
فصل 1

طراحی گرافیکی

گرافیک در واقع زبان بصری مؤثری است که با استفاده از فنون رسم تصویر و رنگ 
این  کند،  القا  مخاطبین  برای  را  مطالب  در  مطرح شده  مفاهیم  اهمیت  دارد  سعی 
بیان برای تمامی مخاطبان در سطوح مختلف ممکن است یکسان نباشد، این هنر 
صاحبان خلق آثار گرافیکی است که بیان مطلب را واضح و مؤثر پیاده سازی کنند. 

است،  اینترنت  و  دیجیتال  ارتباطات  بر  مبتنی  که  حاضر  دنیای  در  گرافیک  زبان 
کارایی زیادی برای جلب مخاطب در دنیای کسب وکار و رسانه های خبری و تبلیغات 
و فرهنگ و هنر دارد. امروزه نرم افزارهای متنوع با امکانات مختلف در حوزه گرافیک 
ایجادشده است. در این فصل در دو واحد یادگیری کار با ابزارهای ساده و پیشرفته 
گرافیکی با مقدمات کار با نرم افزار ایلاستریتور و برخی امکانات آن، آشنا می شوید.
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آیا تا به حال پی برده اید

  نرم افزارهای            گرافیکی در چه اموري کاربرد دارند؟
  تنظیمات کاغذ برای چاپ چگونه است؟

 تصاویر نقش بیتی و برداری چه ویژگی هایی دارند؟
  درج قلم های فارسی در نرم افزار Illustrator چگونه است؟

  کاربرد ماسک در طراحی چیست؟

هدف از این واحد شایستگی، چگونگی کار با ابزارهای ساده و اولیه نرم افزار Illustrator است.

استاندارد  عملکرد

با استفاده از دانش و شناخت محیط نرم افزار گرافیکی، تنظیمات ایجاد سند و تصویرسازی را به کمک اشکال 
آماده و ابزارهای ترسیمی انجام داده، از متن و ماسک استفاده کند و سند را با قالب مناسب برای استفاده در 

سایر پروژه ها ذخیره کند.

  واحد یادگیری 1 

شایستگی كار با ابزارهاي ساده گرافیکي
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تعریف گرافیک 

گرافیک، هنر ارتباط تصویر با مخاطب است. این هنر با استفاده از نقطه، خط، شکل و رنگ در کوتاه ترین زمان، 
بیشترین پیام را به مخاطب مي دهد. هنر گرافیک، هنری بسیار گسترده است و در تمام زوایای دید ما به چشم 
می خورد. از بسته بندی محصولات تا پوسترهای تبلیغاتی و از سربرگ و کارت ویزیت و فاکتور تا لوگو و نشانه، از 
طراحی صحنه و لباس تا تیتراژ و جلوه های ویژه فیلم و از تبلیغات تجاری و تیزرهای تلویزیونی تا نقاشی های متحرک، 

همه و همه با گرافیک آمیخته شده اند.

شکل ١

ارتباط گرافیک و نرم افزار  

در عصر حاضر از انواع نرم افزارها برای کارهای روزمره استفاده می شود که قسمتی از این نرم افزارها در اختیار طراحان 
گرافیک قرار گرفته است. همراه با رشد جمعیت و نوآوری های جدید در عرصه علم و صنعت، نیاز به تبلیغات، روز به 
روز افزایش یافته است و با وجود ظهور تکنولوژی و نرم افزارهای جدید گرافیکی، قابلیت های متعددی در این زمینه 
به وجود آمده است. امروزه طراحان گرافیک با استفاده از نرم افزارهای گرافیکی آثار خود را از طراحی تا چاپ به 
نتیجه مطلوب می رسانند. به طور کلی نرم افزارهای گرافیکی از دو خصوصیت برداری و نقش بیتی پیروی می کنند و 
شرکت های سازنده این نرم افزارها در پی رقابت با یکدیگر، نرم افزارهایی با هر دو خصوصیت را به وجود آورده اند که 

طراحان باید با ویژگی هر یک آشنا شوند.

 )Bitmap(نقش بیتی      
تمامی عکس ها با هر قالبی نقش بیتی هستند. خصوصیت مشترک این عکس ها در این است که از ترکیب یک 
سری اطلاعات پیکسل به پیکسل تهیه شده اند. داده ها در قالب بایت های اطلاعاتی شامل رنگ و موقعیت پیکسل در 
چهارچوب عکس هستند. خروجی نرم افزارهای رایج گرافیکی مثل فتوشاپ همیشه پیکسلی هستند و با بزرگ کردن 

هر یک از تصاویر 1 و 2 چه پیامی به مخاطب ارائه می کنند؟كنجكاوي

شکل 2
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تشکیل دهنده  پیکسل های  3ـ  شکل 
کوچکی  مکعب های  شکل  به   4 شکل 

قابل مشاهده اند.     

شکل 4  

شکل 5  ـ تصویر برداری ترسیم شده در نرم افزار Illustrator که بخشی از آن به میزان قابل توجهی بزرگ شده است.

)Vector( برداری 

در این قالب تصاویر گرافیکی به صورت برداری تعریف می شوند. به این معنی که نقطه با مختصات )X  , Y( و 
خط با استفاده از دو نقطه تعریف می شود. همین طور اطلاعات مربوط به رنگ، ضخامت و ... هم به این اطلاعات 
ریاضی اضافه می شود. شما هر چه تصاویر را بزرگ کنید، پیکسل پیکسل نمی شوند، چون با هر بزرگ نمایی، 
دوباره تصاویر با کمک اطلاعات ریاضی بازسازی می شوند و اگر محدودیت صفحه نمایش ها اجازه می داد این 

تصاویر تا بی نهایت قابل بزرگ نمایی بودند، زیرا به پیکسل ها وابسته نیستند. 

تصاویر شفافیت خود را از دست می دهند و در کناره های تصویر، پدیده شکستگی در لبه ها اتفاق می افتد. حجم این 
پرونده ها بزرگ است و فضای بیشتری را اشغال می کنند. وقتی عکسی را پویش )scan( می کنید پرونده حاصل قالب 
نقش بیتی دارد. پیکسل را در تصاویر دیجیتالی، کوچک ترین بخش تصویر می گویند و در مباحث مربوط به گرافیک 

نقطه  را کوچک ترین عنصر تشکیل دهندۀ تصویر می خوانند.
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 در جدول زیر مشخصات تصاویر برداری و نقش بیتی را بنویسید.

جدول ١ـ مشخصات تصاویر برداری و نقش بیتی

 VectorBitmap

 دیگر کاربردهای تولید تصاویر به کمک نرم افزارهای گرافیکی را بنویسید و یا تصاویر مشابه را جست وجو کرده و 
در محل مناسب   بچسبانید.

فعاليت 
كارگاهي

بسته بندی محصولات

گرافیک محیطی

لوگو

فیلم  ویژه،  جلوه های 
طراحی صنعتیمحمد رسول الله
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  نام نرم افزارهای گرافیک دو بعدی و سه بعدی را در جدول زیر بنویسید.

جدول 2ـ نرم افزارهای گرافیکی

سه بعدی دو بعدی 

 Adobe Illustrator معرفی نرم افزار

یکی از نرم افزارهای قدرتمند که برای طراحی های برداری ارائه شده، Adobe Illustrator است. حجم پایین و 
کیفیت بالا، مهم ترین خصوصیت این نرم افزار گرافیکی برداری است.

 Illustrator کارگاه ١       شروع کار با نرم افزار 

١ نرم افزار Illustrator را اجرا کنید.
در هنگام بارگذاري برنامه، شکل روبه رو ظاهر مي شود. 

این شکل بسته به نسخۀ نرم افزار متفاوت خواهد بود.

فیلم شماره 10201 : انواع نرم افزارهای گرافیکیفيلم

فعاليت 
كارگاهي

فیلم را مشاهده کرده و فعالیت زیر را انجام دهید.
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 نسخه نرم افزار نصب شده روي رایانۀ کارگاه را بخوانید. 

2 برای نمایش یک پنل از منوی Window روی نام پنل کلیک کنید.
در قسمت راست پنجره اصلی برنامه، به طور پیش فرض پنجره های کوچکی وجود دارند که روی سایر پنجره ها باز 
می شود. به این پنجره های کوچک پنل می گویند. پنل ها برای مدیریت عملیات در حین انجام برنامه به کمک کاربر 

می آیند.

نوارها و پنل های موجود در صفحه را بررسی کنید و به کمک هنرآموز خود، عنوان هر یک از بخش های 
تعیین شده را بنویسید. 

شکل 6  ـ محیط نرم افزار

فعاليت 
كارگاهي

فعاليت 
كارگاهي

شکل 7ـ ایجاد سند جدید

3 یک سند جدید ایجاد کنید )شکل 7(.
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4 تنظیمات سند جدید را انجام دهید.
در کادر محاوره ای بازشده در قسمت Profile سند جاری،گزینه Print را انتخاب و پیش تنظیمات برای انجام 
عملیات چاپی را بررسی کرده و نام هریک از بخش های نشان داده شده را در کادر مربوطه بنویسید )شکل 8(. 

New Document شکل 8  ـ کادر محاوره ای

در ایران واحد اندازه گیری )Unit( سندهای چاپی mm و cm انتخاب می شود. ولی واحد اندازه گیری سندهای 
وبی که برای صفحات اینترنتی و نمایشی مناسب هستند، بر اساس واحد pixel است.

فعاليت  یک سند جدید در اندازه A4 برای انجام عملیات چاپی و با واحد cm باز کنید.
كارگاهي

 اندازه کاغذ A4، در پیش تنظیمات Print را بنویسید.كنجكاوي



ل: طراحی گرافیکی فصل او ّ

9

        جدول ارزشیابی شایستگی های غیر فنی، ایمنی و بهداشت و توجهات زیست محیطی

 شرایط عملکردشایستگی ها
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن)ابزار،مواد، تجهیزات، زمان، مکان و ...(

کنترل کیفیت ـ نقش در گروه ـ نوآوری در شایستگی های غیرفنی
طراحی ـ زبان فنی

قابل  قبول
توجه به کیفیت نهایی پروژه شامل بررسی اتصال 
صحیح ترسیمات و مفاصل ـ نوآوری در ترسیم ـ 

رعایت حق مالکیت معنوی تصاویر
2

رعایت ارگونوميـ کنترل حفاظتي الکتریکي ایمنی و بهداشت
و الکترونیکي )ابزار و تجهیزات(

ایجاد اسناد الکترونیکی کاهش مصرف کاغذتوجهات زیست محیطی
1توجه به ایمنی و بهداشت محیط کارگاهغیر قابل  قبول

به کارگیری خلاقیت در طراحینگرش

     
      ارزشیابی مرحله 1

 شرایط عملکردمراحل کار
نمرهاستاندارد )شاخص ها/   داوری/   نمره دهی(نتایج ممکن)ابزار، مواد، تجهیزات، زمان، مکان و ...(

آماده سازی سند 
گرافیکی

مکان: کارگاه استاندارد رایانه

نرم افزار گرافیکی  رایانه ای که  تجهیزات: 
روی آن نصب باشد

زمان: 5 دقیقه

بالاتر
 از حد انتظار

تنظیمات ایجاد پرونده گرافیکی چاپی ـ ذخیره با 
قالب پیش فرض ـ بازیابی اسناد ـ فعال و غیر فعال 

کردن پنل ها 
3

در حد انتظار
ایجاد سند با تنظیمات پیش فرض ـ ذخیره با قالب 
پیش فرض ـ بازیابی اسناد ـ فعال و غیر فعال کردن 

پنل ها
2

پایین تر
 ازحد انتظار

1اجرای نرم افزار ـ ایجاد سند با تنظیمات پیش فرض 

آنچه آموختم:

...................................................................................................................................................................................... ١

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت
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در این کارگاه می خواهیم روش ترسیم نقوش هندسی 
را آموزش دهیم. برای نمونه شکل 9 را ترسیم می کنیم.

 A4 ١ یک ســند جدید در حالت افقی و در اندازه
ایجاد کنید.

شکل 29 خطوط شطرنجی را فعال کنید )شکل ١0(. 

شکل ١0ـ فعال کردن خطوط شطرنجی

 کارگاه 2     ترسیم نقوش هندسی

3 یک مربع ترسیم کنید.
 با انتخاب ابزار Rectangle )مستطیل( و کلیک روی 
صفحه، می توان اندازه طول و عرض مستطیل را تنظیم 

کرد )شکل 11(.

Rectangle شکل ١١ـ تعیین طول و عرض

کاربرد نماد  چیست؟كنجكاوي

4 یک نسخه مشابه از مربع رسم شده ایجاد کنید 
)شکل ١2(.

) Rotate(شکل ١2ـ انتخاب ابزار چرخش
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5 تصویر را بچرخانید.
بــرای چرخش یک فرم هندســی بعد از انتخــاب آن از مسیر 
باز شده زاویه چرخش  object>transform>Rotate در پنل 

را وارد کنید )شکل 13(.
به عملیاتی که باعث تغییر یک شــکل یا فرم هندسی می شود 

transform می گویند.

6 با جابه جایی، تصویر جدید را ایجاد کنید )شکل ١4ـ ب(.

7     اشکال را ترکیب کنید.
ابزار Selection را انتخاب کرده، اشکال را انتخاب کنید و به مسیر Window>Pathfinder بروید از پنل 

Pathfinder نماد Unite را برای ترکیب اشکال انتخاب کنید )شکل 14ـ الف(.

شکل ١3ـ تعیین زاویه چرخش

عملکردگزینه

Move

Reflect

Scale

Shear

فعاليت 
كارگاهي

مســیر  گزینه های  ســایر  عملکرد   
object  >transform را در جدول 

3 بنویسید.

شکل ١4ـ الف ـ پنل Pathficder ـ ترکیب اشکال

شکل ١4 ـ ب

transform جدول 3ـ انواع عملیات
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 کارگاه 3    طراحی با اشکال هندسی

بسیاری از اشکال و فرم هایی که با آنها سروکار داریم را می توانیم با ترکیب اشکال هندسی پایه نظیر مربع، 
دایره و مثلث به دست آوریم. این تجربه باعث می شود تا طراح بتواند از اضافه یا کم کردن و فصل مشترک 
گرفتن از یک فرم ساده به فرم های پیچیده تری دست یابد، در واقع این امر یکی از مهم ترین فنون طراحی به 

شمار می رود.
در این کارگاه قصد داریم شکل کارتونی یک حیوان را ترسیم کنیم.

١  یک سند جدید با ابعاد دلخواه ایجاد کنید. 

2  برای ترسیم بدن حیوان، یک دایره ترسیم کنید.
برای این کار از ابزار Ellipse tool (L) استفاده کنید.

بعد از انتخاب ابزار Ellipse روی صفحه کلیک کنید، چه روی می دهد؟كنجكاوي

شکل ١5

فعاليت 
 زیرمجموعه ابزار فرم های هندسی را باز کرده و با فعال کردن آنها اشکال جدیدی ترسیم کنید.كارگاهي

8 تصویر را تکمیل کنید.
از تصویر به دست آمده نسخه مشابه تهیه کرده و 

در کنار هم چیدمان کنید )شکل 15(.
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3  رنگ دور و داخل دایره را تنظیم کنید.
در ترسیمات انجام شده در Illustrator معمولاً دو بخش دیده می شود. Fill یا بخش پرکننده و Stroke یا 
خط دور. رنگ هر یک از این دو بخش و همچنین ضخامت خط دور )Stroke Weight( قابل تنظیم است. با 
انتخاب ابزار Selection از جعبه ابزار و کلیک روی شکل مورد نظر می توانید آن را انتخاب کرده و ویژگی های 

آن را از نوار کنترل تغییر دهید.

شکل ١6

4  دایره را بچرخانید.
 ابزار Rotate را از جعبه ابزار انتخاب کنید، با نگه داشتن کلید Alt و کشیدن هم زمان ماوس مرکز دوران را به 
زیر دایره بکشید. مرکز دوران نقطه ای است که چرخش حول آن انجام می شود که به طور پیش فرض در مرکز 
شکل قرار دارد. بعد از رها کردن کلید Alt درکادر ظاهر شده در بخش Angle ، زاویه چرخش را با عبارت 

360/9 وارد کنید و روی دکمه Copy کلیک کنید. نتیجه کار چیست؟

در  شده  مشخص  مثلث  روی  کلیک  با 
یک  می شود،  ظاهر  رنگ  پنل   1 بخش 
داخل  برای  بخش  این  از  دلخواه  رنگ 
دایره انتخاب کنید، روی مثلث مشخص 
شده در بخش 2 کلیک کنید و از پنل 
کنید،  انتخاب  را  نماد   ظاهر شده 
بدون  دایره  دور  می شود  کار سبب  این 

رنگ باشد.

شکل ١7
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5    با زدن کلید های Ctrl+D به تعداد 
ایجاد  مشابه  نسخه  دایره  از  مناسب 

کنید )شکل ١8(.

شکل ١8

شکل ١9

شکل 20

شکل 2١

را بـه  6    همه اشکـال ترسیم شده 
صورت یک شکل واحد درآورید.

یک دایره در قسمت سفید رنگ قرار دهید 
ابزار  با  شود،  ایجاد  بسته  فضای  یک  تا 
Selection همه دایره ها را انتخاب کنید، 
از منوی Windowگزینه Pathfinder را 
انتخاب کنید، در این پنل بر روی گزینه 
این  به  )شکل 19(.  کنید  کلیک   Unit

ترتیب بدن گوسفند آماده شد.

در  گـوشه گـرد  مستطیل  یک   7
موقعیت مشخص شده بکشید )شکل 

 .)20
 Rounded Rectangle tool ابزار  از 

استفاده کنید.

8 برای ترسیم سر، سه دایره ترکیبی 
در  دور  خط  بدون  و  سفید  رنگ  با 
)شکل  دهید  قرار  مناسب  موقعیت 

.)2١
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9 برای ترسیم گوش، یک نیم دایره ترسیم کنید.
برای این مرحله ابتدا یک دایره، سپس یک مستطیل روی 
 Minus روی نماد Pathfinder آن ترسیم کنید. در پنل
کلیک کنید تا شکل مستطیل از دایره کم شود )شکل 22(.

١0  شکل ایجادشده را در مکان صحیح قرار داده و 

آن را به میزان مناسب دوران دهید.
 با توجه به شکل نیم دایره باید به پشت منتقل شود برای 
انجام این کار می توانید از گزینه Send Backward واقع 
 Ctrl+[ یا از کلیدهای میانبر object>Arrange در مسیر

استفاده کنید )شکل 23(.

١١ یک نسخه قرینه از شیء ترسیم شده ایجاد کنید.

انتخاب کرده سپس  را  نیم دایره  برای تهیه نسخه مشابه، 
گزینه Reflect را از مسیر object>transform انتخاب 
کنید، در کادر ظاهر شده گزینه Vertical را انتخاب کنید 
و  کنید  کلیک   Copy دکمه  روی  بر  )شکل 24(، سپس 

نسخه مشابه را در جای مناسب قرار دهید.

١2 سایر قسمت ها را به طرح اضافه کنید )شکل 25(. 

آنها  کردن  یکی  و  گوشه گرد  مستطیل  چهار  ترکیب  از 
مستطیل  دو  از  و  کنید  ایجاد  را  دهان  و  بینی   )Unit(

گوشه گرد برای پاها استفاده کنید.

شکل 24

شکل 22

شکل 23

شکل 25
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فعاليت 
كارگاهي

 کارگاه 4     طراحی با استفاده از شکل دایره

در این کارگاه با شکل های آماده گلبرگ های یک گل را 
طراحی می کنیم.

١ یک سند چاپی و در قطع A4 باز کنید.

خطوط  و  رنگ  بدون   fill حالت  در  بیضی  یک   2
محیطی به ضخامت pt 2 ترسیم کنید)شکل 26(.

3 روی شکل تغییر ایجاد کنید.
با استفاده از ابزار Direct Selection (A) ابتدا همانند 
شکل 27 نقطه پایین دایره را انتخاب کرده و با استفاده از 
 Convert Selected Anchor Point to Corner نماد
نقطه   28 شکل  مانند  سپس  دهید،  شکل  تغییر  را  آن 

بالای فرم را انتخاب و آن را تغییر دهید.

شکل 26ـ تنظیم ویژگی های دایره

شکل27ـ تغییر شکل انتخابی شکل 28

برخی اشکال زیر را در  کارگاه و یا منزل ترسیم کنید.
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4 گلبرگ را دوران دهید و یک نسخه مشابه از آن را ایجاد کنید.
گلبرگ را حول نقطۀ پایین آن بچرخانید )شکل 29(.

5 شکل را تکمیل کنید.

میانبر  کلید  یا   transform again گزینۀ  انتخاب  با 
هم  کنار  در  دوران  مرکز  حول  گلبرگ ها   Ctrl + D
 transform again چیده می شوند )شکل 30(. گزینۀ

آخرین transform انجام شده را تکرار می کند.

شکل 29ـ تعیین اندازه زاویه چرخش

شکل 30ـ ایجاد نسخه مشابه شکل

6 سند را با قالب عمومی )EPS( ذخیره کنید.

EPS (Encapsulated Post Script) یک قالب عمومی 
است که اکثر طراحان هنگامی که می خواهند کار را برای 
از طرح در  یا زمانی که می خواهند  چاپ آماده کنند و 
 QuarkXPress و   Indesign صفحه آرایی  نرم افزارهای 

خروجی بگیرند، از آن استفاده می کنند.
 به مسیر File > Save As بروید و EPS را به عنوان 

file type انتخاب کنید. 

زمانی که کلید Save را انتخاب می کنید پنل تنظیمات 
EPS باز خواهد شد )شکل31(. بدون تغییر در تنظیمات 

پیش فرض، اطلاعات را ذخیره کنید. 

 Illustrator شاید لازم باشد آن را در یک نسخه پایین تر
ذخیره کنید چون ممکن است فردی که می خواهد از آن 
استفاده کند هنگام باز کردن پرونده با مشکل مواجه شود.

EPS شکل 3١ـ پنل تنظیمات
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Version: اگر می خواهید مطمئن باشــید که خروجی شما با همه برنامه ها سازگار است Illustrator 8.0 را انتخاب 
کنید. 

Preview Format: یک پیش نمایش سریع از طرح در هنگام وارد شدن به یک نرم افزار دیگر به شما نشان 
می دهد.

Embed Fonts: اگر می خواهید درخروجی EPS قلم های استفاده شده، در طرح قرار گیرد و هنگامی که فرد 
دیگری آن را باز می کند قلم ها در دسترس او باشد، این قسمت را فعال کنید.

ارزشیابی مرحله 2

 شرایط عملکردمراحل کار
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن)ابزار،مواد، تجهیزات، زمان، مکان و ...(

تصویرسازی  با 
استفاده از اشکال 

هندسی

مکان : کارگاه استاندارد رایانه

تجهیــزات: رایانــه ای کــه نرم افــزار گرافیکــی 
روی آن نصــب باشــد

زمان: 15 دقیقه

بالاتر از حد انتظار

با  اشکال  ـ چرخش  تنظیمات  انجام  با  رسم شکل 
تعیین مرکز دوران ـ انعکاس شکل  ـ ترکیب اشکال ـ 
کم کردن اشکال از یکدیگر ـ ایجاد خروجی با قالب 

عمومی

3

در حد انتظار
با  اشکال  ـ چرخش  تنظیمات   انجام  با  رسم شکل 
ایجاد  شکل  ـ  انعکاس  پیش فرض  ـ  دوران  مرکز 

عمومی قالب  با  خروجی 
2

ایجاد خروجی پایین تر از حد انتظار با تنظیمات پیش فرض ـ  رسم شکل 
1با قالب عمومی

آنچه آموختم:

...................................................................................................................................................................................... ١

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت
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Anchor point

شکل 32

 Pencil شکل 33ـ ابزار

شکل 34ـ پنل رنگ

در این کارگاه قصد داریم روش ترسیم شکل 32 را 
آموزش دهیم.

١ یک سند جدید در اندازه A4 ایجاد کنید.
2 ابزار Pencil را انتخاب کنید )شکل 33(.

با انتخاب این ابزار و کشیدن ماوس روی محل 
ترسیم، می توان شکل مورد نظر را ترسیم کرد.

3 رنگ ترسیم را انتخاب کنید )شکل 34(.
 در بخش پایین جعبه ابزار، دو مربع برای تنظیم 
رنگ Fill و Stroke قــرار دارد. روی ابزار مربع 
دابل کلیک کرده، ســپس از پنل باز شــده رنگ 

دلخواه را انتخاب کنید. 

 Pencil کارگاه 5      ترسیم با ابزار 
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4 با استفاده از ابزار Pencil مراحل شکل 35 را به ترتیب اجرا کنید.

١ 2

4 6

3

5

شکل 35

5 ضخامت خطوط را تغییر دهید.
برای تغییر ضخامت خطوط، ابتدا خط مورد نظر را با ابزار Selection انتخاب کرده و سپس عدد موردنظر 

را در نوار کنترل وارد کنید )شکل 36(.

شکل 36ـ تغییر ضخامت خطوط
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6 ضخامت و شکل خطوط را تغییر دهید )شکل 37(.
برای زیبایی تصویر، ضخامت خط های ترسیم شده را متفاوت انتخاب کنید.

شکل 37ـ تغییر شکل خطوط

ذخیره سند با پسوند پیش فرض نرم افزار Illustrator یعنی Ai صورت خواهد گرفت. 

یکی از مهم ترین ابزارهای نرم افزار Illustrator ابزار Pen است. از این ابزار برای ایجاد مسیر به منظور طراحی 
اشکال استفاده می شود. با استفاده از ابزار Pen، می توانیم خطوط و منحنی هایی ایجاد کنیم و با ترکیب آنها 

اشکال متنوعی خلق کنیم.
به دلیل اهمیت ابزار Pen قبل از شروع ترسیم، با مسیر )Path( آشنا می شویم. مسیرها مجموعه ای از خطوط 
مستقیم و یا منحنی و یا هر دو هستند )شکل 38(. مسیرها از نقاطی به نام Anchor Point یا نقاط لنگری 
)بخش 1 شکل 38( تشکیل شده اند که هر یک از این نقاط قابلیت ویرایش و تغییر دارند. در یک مسیر به 
فاصله بین هر دو نقطه، یک قطعه مسیر )Path Segment( می گوییم )بخش 2 شکل 38(. در برخی نقاط 

  Pen ابزار

آنچه آموختم:

...................................................................................................................................................................................... ١

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

یادداشت

برداشت
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لنگری دستگیره هایی برای تغییر جهت منحنی وجود دارد که به آن Direction Handle گفته می شود 
)بخش 3 شکل 38(. برای ویرایش این دستگیره ها از نقاط تغییر جهت )Direction Point( استفاده می شود 

)بخش 4 شکل 38(.

به طور کلی دو نوع نقطه در مسیر وجود دارد:
الف( نقطه گوشه )Corner Point(: باعث اتصال تیز دو مسیر 

به هم می شود )شکل 39(.
ب( نقطه منحنی )Curve Point(: باعث اتصال نرم دو مسیر 

به هم می شود )شکل 40(.
 1ـ نقاط منحنی به سه دسته تقسیم می شوند:

نقطه ای  دو طرف  اگر   :)Symmetrical( متقارن  نقطه  الف( 
تغییر  اهرم و دستگیره  باشد، در هر دو طرف دارای  منحنی 
شکل خواهد بود. اگر نقطه ای متقارن باشد این دستگیره ها دو 

ویژگی دارند:
دستگیره  دستگیره،  یک  رفتن  بالا  با  یعنی  که  الاکلنگی   

مقابل پایین می رود و بالعکس.
 همواره اندازه دو دستگیره با هم برابر است؛ یعنی با تغییر 

اندازه یکی دیگری نیز تغییر می کند )شکل 41(.

شکل 38ـ یک مسیر ترکیبی از خطوط مستقیم و منحنی

در مسیر شکل 38 چند قطعه مسیر وجود دارد؟كنجكاوي

شکل 39 ـ نقطه گوشه

  شکل 40 ـ نقطه منحنی

شکل 4١                              شکل 42                                     شکل 43
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ب( نقطه نامتقارن )Smooth(: نقطه ای که دو طرف آن دارای اهرم است که هر اهرم را می توان جداگانه 
بزرگ و کوچک کرد. اگر یکی از اهرم ها را بگیرید و بکشید و طول هر یک از اهرم ها را کم یا زیاد کنید، این 
کم و زیاد شدن، فقط روی همان منحنی تأثیر می گذارد. اگر یکی از اهرم ها را بگیرید و تغییر زاویه دهید 

دیگری نیز برای حفظ تعادل الاکلنگ در جهت مخالف حرکت می کند )شکل 42(.
2ـ نقطه نوک تیز )Cusp(: نقطه ای است که در آن می توانید دستگیره ها و اهرم های آن را کاملًا مستقل از هم 
دست کاری کرده و تغییر دهید. قوس های طرفین در حالی که کاملًا به هم متصل هستند اما از هم مستقل 

هستند )شکل 43(.
چگونه می توانیم این نقاط را به وجود آوریم:

 a نقاط متقارن الاکلنگی فقط در هنگام ترسیم ایجاد می شوند و بعد از آن وجود نخواهند داشت. ابتدا در نقطه
کلیک کنید ماوس را در نقطه b قرار دهید و درگ کنید. قبل از اینکه ماوس را رها کنید مشاهده می کنید که 

دستگیره ها به صورت متقارن تغییر می کنند )شکل 44(.
نقاط نامتقارن بعد از ترسیم ایجاد می شوند. در نقطه a کلیک کنید، در نقطه b کلیک و درگ کنید. در پایان در 
 b روی نقطه Direct Selection را بفشارید. حالا اگر با ابزار Esc کلیک کنید برای اتمام ترسیم دکمه c نقطه

کلیک کنید دستگیره ها ظاهر می شوند اما به صورت غیر متقارن و الاکلنگی تغییر می کنند )شکل 45(.
برای ایجاد نقطه نوک تیز مطابق شکل 46 ابتدا در نقطه a کلیک کنید. در نقطه b کلیک و درگ کنید، دکمه 
ماوس را رها کنید. حالا با پایین نگاه داشتن کلید Alt و به کمک ماوس می توانید دستگیره ها را به صورت 

مستقل تغییر دهید.

شکل 44                                         شکل 45                                              شکل 46

کنترل  نوار  در   Anchor Point بخش  در  موجود  گزینه های  از  می توانید  یکدیگر  به  نقطه ها  تبدیل  برای 
استفاده کنید )شکل 47(.

شکل 47
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در این کارگاه قصد داریم شکل پرنده را ترسیم 
کنیم.

 800  ×  600  pixel ابعاد  با  سند  یک   ١
ایجاد کنید.

2 ابزار Pen tool را از جعبه ابزار انتخاب کنید 
)شکل 48(.

  Pen کارگاه 6      ترسیم با ابزار 

Pen شکل 48 ـ ابزار

نظر  در  رنگ سیاه   Stroke برای  و  دهید  قرار   None حالت  در  را   Fill ترسیم  از شروع  3   قبل 
بگیرید.

4  بدن پرنده را ترسیم کنید.
در نقطه 1 کلیک به همراه درگ انجام دهید، در نقطه 2 و 3 نیز همین کار را انجام دهید. بعد از اینکه منحنی 
مورد نظر در نقطه 3 ایجاد شد ابتدا دکمه ماوس را رها کرده و مجدد بر روی نقطه 3 کلیک کنید تا بتوانید 
یک قطعه مسیر جدید ترسیم کنید. در نقطه 4 و 5 و 6 نیز مانند نقطه 3 عمل کنید. در نقطه 7 کلیک کنید. 
دکمه ماوس را رها کنید. دکمه Alt را پایین نگاه داشته و به کمک ماوس دستگیره را مانند شکل 49 در 
جهت مناسب قرار دهید. در نقطه 1 کلیک کنید دکمه Alt را پایین نگاه داشته و به کمک ماوس دستگیره 
به کمک  را  نقاط   Direct Selection ابزار  به کمک  ترسیم  پایان  از  بعد  دهید.  قرار  مناسب  در جهت  را 

دستگیره ها ویرایش کنید تا به فرم مناسب برسید.

شکل 49
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5  بال پرنده را نیز با همین روش ترسیم کنید )شکل 50(.
بعد از ترسیم بال برای ویژگی Fill در نوار کنترل رنگ سفید در نظر بگیرید. سر بال پرنده کمی ناهموار است 
)شکل 50(. برای رفع این مشکل دستور Simplify را از مسیر Object > Path با پارامترهای مناسب بر روی 

مسیر اجرا کنید )شکل 51(.

6  شکل را تکمیل و رنگ آمیزی کنید.

شکل 50                                            شکل 5١                                                           شکل 52

شکل 53

 Anchor Point tool و Delete Anchor Point tool ،Add Anchor Point tool کاربرد ابزار های
را در قالب یک تمرین عملی با هم گروهی خود بررسی کنید.

 با انتخاب یک نقطه منحنی و فشردن کلید  S از صفحه کلید چه روی می دهد؟كنجكاوي

برخی شکل های روبه رو 
را با راهنمایی هنر آموز 

ترسیم کنید.

فعاليت 
كارگاهي

فعاليت 
گروهی
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یکی از مهم ترین نکات در مورد ترسیم اشکال و منحنی ها به کمک ابزار Pen این است که استفاده از نقاط 
کمتر باعث ترسیم منحنی های زیباتر و نرم تر خواهد شد.

فعاليت 
شکل زیر را به کمک هنر آموز ترسیم کنید.كارگاهي

پژوهش
در مورد کاربرد کلید های Alt   ،Ctrl و Shift هنگام کار با ابزار Pen تحقیق کنید.

 کارگاه 7     ترسیم تصاویر  برداری از نقش بیتی

فعاليت 
كارگاهي

یکی از آثار تاریخی شهرتان را انتخاب کرده و اجرا کنید.

فیلم شماره 10202 : ترسیم تصاویر  برداری از تصاویر نقش بیتیفيلم

فیلم را مشاهده کرده و فعالیت را انجام دهید.
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Illustrator کارگاه 8      فارسی نویسی در نرم افزار 

 با استفاده از قلم های فارسی، تابلویی را برای سردر  کارگاه یا مدرسه خود طراحی کنید.

ارزشیابی مرحله 3

فيلم
Illustrator فیلم شماره 10203: فارسی نویسی در نرم افزار

فعاليت 
كارگاهي

 شرایط عملکردمراحل کار
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن)ابزار، مواد، تجهیزات، زمان، مکان و ...(

تصویرسازی  با 
استفاده از ابزارهای 

ترسیمی

مکان: کارگاه استاندارد رایانه

تجهیزات : رایانه ای که نرم افزار گرافیکی  روی 
آن نصب باشد

زمان: 20 دقیقه

بالاتر از حد انتظار
تغییر  آن ـ  تنظیمات  و   Pencil ابزار  با  ترسیم 
نوع نقطه ـ ترسیم مسیر با ابزار Pen و ویرایش 

مسیر 
3

تغییر در حد انتظار آن ـ  تنظیمات  و   Pencil ابزار  با  ترسیم 
نقطه 2نوع 

پایین تر
 از حد انتظار

Pencil 1ترسیم با ابزار

آنچه آموختم:

...................................................................................................................................................................................... ١

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

پس از مشاهده فیلم، فعالیت زیر را انجام دهید.

برداشت
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انواع  ماسک   

به وسیله ماسک )لفافه، پوشانه( می توان محدوده خاصی از یک تصویر را قابل نمایش یا ویرایش کرد. بخشی که 
خارج از این محدوده قرار دارد غیرقابل نمایش و ویرایش خواهد بود. برای ایجاد این محدوده می توانید از اشکال 
 Pen هندسی ساده نظیر مربع، مستطیل، دایره، بیضی، ستاره، چندضلعی و یا مسیرهای بسته ای که توسط ابزار

ایجاد می شود استفاده کنید. این محدوده می تواند یک متن هم باشد. 
انواع ماسک ها در نرم افزار Illustrator عبارت اند از:

1ـ Clipping Mask )ماسک برشی(
2ـ  opacity Mask )ماسک شفافیت(

از یک تصویر را مخفی کرد. در واقع شکلی که روی تصویر قرار  به وسیله ماسک برشی می توان بخش هایی 
می گیرد و تبدیل به یک ماسک برشی می شود، باعث برش خوردن تصویر در آن بخش می شود. بنابراین بخش 
برش خورده تصویر قابل نمایش شده و بخش هایی که خارج از این محدوده هستند تحت تأثیر ماسک باقی مانده 

و نمایش داده نمی شوند.

ارزشیابی مرحله 4

 شرایط عملکردمراحل کار
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن)ابزار، مواد، تجهیزات، زمان، مکان و ...(

استفاده از 
متن در فایل 

گرافیکی

مکان: کارگاه استاندارد رایانه

تجهیزات:   رایانه ای کـه نـرم افزار گرافیکـی و 
فارسی ساز روی آن نصب باشد

زمان: 20 دقیقه

درج متن فارسی و انگلیسی در صفحه و روی مسیر بالاتر از حد انتظار
3و قالب بندی آن ـ ویرایش هنری متن

درج متن فارسی و انگلیسی در صفحه و روی مسیر در حد انتظار
2و قالب بندی آن

پایین تر
 از حد انتظار

1درج متن انگلیسی در صفحه و قالب بندی آن

آنچه آموختم:

...................................................................................................................................................................................... ١

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت
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 کارگاه 9      طراحی جلد و برچسب لوح نوری

در این کارگاه به کمک ماسک می خواهیم جلد لوح 
نوری و برچسب آن را طراحی کنیم. 

١   برای ایجاد برچسب لوح نوری یک سند جدید 
بازکنید.

2  طرح اصلی را ایجاد کنید. 
دایره ای به قطر 116میلی متر، ترسیم کنید و در مرکز 
این دایره، دایره ای به قطر 24 میلی متر رسم کنید. از 

امکانات بخش Align کمک بگیرید.

از  را  دایره کوچک   Minus گزینه  به کمک    3
دایره بزرگ کم کنید.

آماده  الگوهای  از  می توانید  لوح  برچسب  ایجاد  برای 
نرم افزار نیز استفاده کنید. برای دسترسی به این الگوها 
گزینه New from template را از منوی File اجرا 
 Blank templates کنید. در کادر ظاهرشده پوشه
برای  دارد.  وجود  تعریف شده  پیش  از  الگوی  چندین 
 CD Print Items ایجاد برچسب لوح نوری می توانید از الگوی

استفاده کنید. 

4  تصویر برچسب لوح را ماسک کنید.
شکل رسم شده را روی تصویری که به عنوان برچسب 
شکل  و  تصویر  دهید.  قرار  گرفته اید،  نظر  در  لوح 

ترسیم شده را انتخاب کنید )شکل54(.

شکل 54
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سپس از مسیر object>Cipping Mask>Make یک 
ماسک برشی ایجاد کنید.

با گزینه Edit Contents می توان محل قرارگیری برچسب 
را ویرایش کرد )شکل 55(.

در روش دوم ایجاد مـاسک بـرشی بعد از انتخاب شکل و 
دکمه  روی  بر   transparency پنل  در  می توانید  تصویر 

Make Mask کلیک کنید.

شکل 55

شکل 56

تحقیق پژوهش شفافیت  ماسک  ایجاد  اصول  مورد  در 
. کنید

5 لوگو موردنظر را در محل مناسب قرار دهید.

 

6 عنوان لوح نوری را در محل موردنظر بنویسید.
برای عنوان لوح نوری، عبارت تولید محتوای الکترونیک و 
برنامه سازی را بنویسید و با ابزار Vertical type، عنوان 
را بنویسید. در صورت نیاز متن را بچرخانید )شکل 57(.

7  صفحه گسترده جلد لوح را ترسیم کنید.
برای ترسیم صفحه گسترده جلد از پنل Artboards یک 
Artboard جدید به سند اضافه کنید. سپس مربعی در 

ابعاد cm 13×13رسم کنید.

شکل 57
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شکل 59

8  خط چین ها را ترسیم کنید.
به   Window> Brush Libraries>Borders>Borders_Dashed مسیر  از  استفاده  با  را  مربع  خطوط 

خطوط خط چین تغییر دهید.

شکل 58

شکل60                               شکل6١

9  صفحه گسترده را تکمیل کنید.
 Scissors مربع دیگری با همان ابعاد، ترسیم کرده و با ابزار
)قیچی( بر روی دو گوشه بالای مربع کلیک و سپس ضلع 
بالایی را جدا کرده و حذف کنید. این مربع را زیر مربع قبلی 

قرار دهید )شکل 58(.

١0  قسمت تاشوی درِ پاکت را ایجاد کنید.

یک مستطیل در اندازه های 2/5×13 سانتی متر رسم کنید. 
با استفاده از ابزار Direct selection دو نقطه بالا را انتخاب 
کنید. کلید S را از صفحه کلید بزنید، به کمک ماوس یکی از 
نقاط را به سمت داخل بکشید. ضلع پایین آن را حذف کرده، 

سپس آن را بالای مربع خط چین قرار دهید.

١١  کناره های پاکت را ایجاد کنید.

مانند  و  کرده  ترسیم  سانتی متر  ابعاد 13×2  در  مستطیلی 
مرحله قبل برای ضلع سمت چپ آن زوایای تند ایجاد کنید. 
را  کناره ها  داخلی  ضلع   ،  Scissors ابزار  کمک  به  سپس 
حذف کرده و آن را در محل مناسب قرار دهید. به همین 

ترتیب کناره دیگر را ایجاد کنید )شکل60(.
آیا روش سریع تری برای این کار وجود دارد؟

١2 ترسیم را رنگ کـرده و بـه آن متن اضافـه کنید. 

)شکل 6١(
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شکل62

برچسب لوح نوری شکل زیر را ترسیم کنید. یک 
پاکت مناسب نیز برای آن طراحی کنید.

فعاليت 
كارگاهي

ارزشیابی مرحله 5

 شرایط عملکردمراحل کار
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن)ابزار، مواد، تجهیزات، زمان، مکان و ...(

استفاده ازماسک

مکان : کارگاه استاندارد رایانه
تجهیزات : رایانه ای کـه نـرم افزار گرافیکــی

 روی آن نصب باشد
زمان : 10 دقیقه

3تبدیل شکل به ماسک ـ ویرایش محتویات ماسکبالاتر از حد انتظار

2رسم شکل ماسک و تبدیل آن به ماسک در حد انتظار

1رسم شکل ماسکپایین ترازحدانتظار

 معیار شایستگی انجام کار:
کسب حداقل نمره 2 از مراحل تصویرسازی با استفاده از اشکال هندسی، تصویرسازی با استفاده از ابزارهای ترسیمی و استفاده از متن

 کسب حداقل نمره 2 از بخش شایستگی های غیر فنی، ایمنی، بهداشت، توجهات زیست محیطی و نگرش 
کسب حداقل میانگین 2 از مراحل کار



جدول ارزشیابی پایانی

شرح کار:
١ آماده سازی سند گرافیکی

2 تصویرسازی با استفاده از اشکال هندسی
تصویرسازی با استفاده از ابزارهای ترسیمی 3

4 استفاده از متن
5 استفاده از ماسک

استاندارد عملکرد: 
با استفاده از دانش و شناخت محیط نرم افزارهای گرافیکی تنظیمات ایجاد سند، تصویرسازی به کمک اشکال هندسی و ابزارهای ترسیمی را انجام داده، از 

متن و ماسک استفاده کند و سند را با قالب مناسب برای استفاده در سایر پروژه ها ذخیره کند.

شاخص ها:

شماره
 مرحله کار

شاخص های مرحله کار

انتخاب تنظیمات پرونده گرافیکی چاپی و تعیین مقدار آن ـ ذخیره با قالب پیش فرض ـ بازیابی اسناد از مسیر تعیین شده ـ  فعال و غیر فعال کردن پنل ها1

انتخاب شکل هندسی ـ انجام تنظیمات رسم شکل هندسی ـ تغییر محل مرکز دوران ـ چرخش شکل ـ انتخاب نحوه انعکاس شکل ـ ترکیب اشکال ـ کم کردن 2
اشکال از یکدیگر ـ تنظیمات ایجاد خروجی با قالب عمومی

انتخاب ابزار Pen و Pencil برای ترسیم مسیر با توجه به کاربرد ـ انتخاب ابزار برای ویرایش مسیر 3

انتخاب ابزار برای واردکردن متن ـ قالب بندی متن ـ ویرایش هنری متن ـ اعمال جلوه به متن4

رسم شکل ماسک ـ انتخاب نوع ماسک ـ تبدیل شکل به ماسک ـ ویرایش محتویات ماسک5

شرایط انجام کار و ابزار و تجهیزات:
مکان : کارگاه رایانه مطابق استاندارد تجهیزات هنرستان ها

تجهیزات :  رایانه ای که نرم افزار گرافیکی و فارسی ساز روی آن نصب باشد
زمان : 70 دقیقه )آماده سازی سند گرافیکی 5 دقیقه ـ تصویرسازی با استفاده از اشکال هندسی 15 دقیقه ـ تصویرسازی با استفاده از ابزارهای ترسیمی 

20 دقیقه ـ استفاده از متن 20 دقیقه ـ استفاده از ماسک 10 دقیقه(

معیار شایستگی:

مرحله کارردیف
حداقل

 نمره قبولی از 3 
نمره هنرجو

1آماده سازی سند گرافیکی١

2تصویرسازی با استفاده از اشکال هندسی2

2تصویرسازی با استفاده از ابزارهای ترسیمی3

2استفاده از متن4

1استفاده از ماسک5

شایستگی های غیر فنی، ایمنی، بهداشت، توجهات زیست محیطی و نگرش:
کنترل کیفیت ـ نوآوری در طراحی ـ نقش در گروه ـ زبان فنی ـ رعایت ارگونومی ـ کنترل حفاظتي الکتریکي و الکترونیکي 

)ابزار و تجهیزات( ـ ایجاد اسناد الکترونیکی کاهش مصرف کاغذ ـ به کارگیری خلاقیت در طراحی
2

*میانگین نمرات

*  حداقل میانگین نمرات هنرجو برای قبولی و کسب شایستگی، 2  است.
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